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Attention – installation technician - 
please read this page first! 
 
Preliminary hints for the installation staff - the complete installation must then be carried 
out exactly according to the instructions in the installation manual. 
All information for installation and operation of the CPA system is found in the 
„CPA system installation manual“ and here: www.schaefer-physik.de/downloads 
 
Attention: for full operation and alarming of the CPA system NO internet-
connection but ONLY a gsm-mobile phone connection is required. 
 
Installation steps: 
1. learn about the CPA system> brochure> or here: www.schaefer-physik.de 
2. checking the scope of delivery (content of the transportation box) 
3. studying the installation manual 
 
Clarification with the owner: 
- clarify with the owner the CPA sensor-unit position at an outside wall of the building,  
  as near as possible to the main entrance 
  Attention: maximum CPA sensor-cable length = 25 meters / 75 feet 
- clarify with the owner the CPA central control box position inside the building 
  Attention: maximum CPA sensor-cable length = 25 meters / 75 feet 
- providing a sim card standard size 25 mm without pin! (e.g. typical for alarm devices 
   and only gsm / telephone / sms – function > without internet function 
- receiving up to 5 telephone numbers from the owner for gsm-sms-alerting 
 
Hardware installation: 
- mounting the CPA sensor-unit at an outside wall of the building 
- mounting the CPA central control box inside the building, max 25 m distant from the  
  CPA sensor 
- laying the CPA sensor-cable to the CPA central control box 
- connecting the CPA sensor-cable in the CPA central control box 
- checking twice the CPA sensor-cable wiring in the CPA central control box 
- connecting the CPA central control box with the 230 Volt mains supply 
- setting the functions of the CPA monitor-unit 
- checking the CPA system for proper function (permanent optical and 
  acoustical pulse display) 
 
Software installation: 
- providing a windows pc 
- transfer the CPA software installation folder from the USB stick / CD-ROM to 
  the hard disc of the windows pc 
- inserting the sim card into the CPA gsm-unit 
- connecting the usb cable to the CPA gsm-unit and the windows pc 
- installing the software according to the CPA installation manual 
- finally send a test sms and check 
 
Final steps: 
- place the remaining spare parts set in the lower right corner of the 
  CPA central control box 
- close the door of the CPA central control box 
- place the CPA installation manual at the top left of the CPA central control box 
- check that the right upper side of the CPA central control box is completely free (antenna) 
- hand over the „CPA system user-information“ brochure to the owner 
- set up a service contract (voluntary) with the owner
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The CPA Cancer Protection Autosystem 

(please study also our homepage: www.schaefer-physik.de) 

 
How is the CPA system installed outside and inside the building? 
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What is the CPA system?  
 
and see the instruction-video “The CPA system function & test.mp4” 
here: usb-stick/cd-rom or www.schaefer-physik.de/downloads 
 
The CPA Cancer Protection Autosystem is a revolutionary new and worldwide unique fully 
automatic high tech protection system - based on artificial intelligence - against different 
types of life threatening attacks or accidents that are caused by highly life- and health-
threatening substances (e.g. nuclear/radioactive) imperceptibly approaching your home 
area and threatening your health and life. The CPA system scans and watches the 
environment permanently and activates an alarm in case of a danger and sends an 
immediate sms-cellphone message to up to five different cellphone-numbers to its owner. 
An alarm switching output for alarm-devices (flashlight, siren, etc.) is supplied for the use in 
areas without or temporarily not available cellphone-net. 
 
The CPA system works fully automatic 24/7/365 and needs no knowledge nor any operation 
or care by its user. It has no control-knobs or other operation elements. It works around the 
clock fully automatic and its power consumption is below 15 (fifteen) watts! 
 
The CPA system: 
 

 
 
 
Technical data: 
 
mains-supply EU version = 230 vac / 50 Hz / single phase 
mains-supply USA version= 120 vac / 60 Hz / single phase 
total power consumption = less than 120 watts 
CPA central control box size = w 500 x h 400 x d 210 mm 
CPA central control box weight = 13,5 kg 
 
CPA sensor-unit size = 190 x 100 mm 
CPA sensor-unit weight = 1,0 kg (w/o cable) 
CPA sensor-unit cable length = max. 25 meters = 75 ft 
caution: sensor-cable contains high voltage 
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CPA system – cellphone function 
 

 
 
Important: at the installation location of the CPA system 
there must be a reliable cellphone connection of the sim 
card provider’s net. 
 
An internet-connection is not requested.

The cellphone has no influence on the CPA system’s 
functions. The CPA system is fully operational even if the 
cellphone is switched off. 
 
The cellphone serves only as a monitor-display for he 
CPA system’s messages. 
 
Messages from the CPA system are sent to the cellphone 
as telephone-sms type. Therefore no internet connection, 
app, cloud or similar is requested. 
 
And therefore your data can not be collected or stored, 
because it does not appear in the internet. 
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Equipment needed for installation and programming 
 
1. for the CPA system hardware installation: 
 
- wall drilling machine with 10 mm drill for CPA sensor-cable 
- wall drills 8 and 6 mm for dowels 
- silicone to tighten the cable hole 
- cleaning equipment 
- soldering iron for tinning wire ends only 
- normal electronic installation tools like screw-drivers etc. 
- digital voltmeter ac/dc max.750 v ac/dc 
- a complete set of accessories is included 
 
outside wall CPA sensor-unit installation sample 
 

 
 
2. for the CPA system software installation 
and programming of the CPA gsm-unit: 
 
- WINDOWS-pc (WIN7, 8, 10 - 64 or 32 bit) with usb-connector  
- usb-mini cable (enclosed) 
- CPA gsm-unit programming software (enclosed) 
 
- providing a sim card standard size 25 mm without pin! (e.g. typical for alarm devices 
   and only gsm / telephone / sms – function > without internet function 
 
Important: there must be a reliable mobile phone connection of the selected sim 
card provider at the installation site of the CPA system. 
 
- the customer’s smartphone-number(s) - max. five 
 
The enclosed software usb-stick and/or cd-rom contains:  
 
- all manuals in pdf-format  
- the complete CPA gsm-module programming software  
 
Both can also be downloaded from: 
www.schaefer-physik.de 
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CPA system  
hardware installation manual 

 
1. The CPA system switching it on and off 
 
Important: the CPA system has no main–switch: when connected to the mains 
supply it runs continuously and should never be cut-off from the mains supply. 
Power cut-off is only possible by removing the main-fuse at the CPA central control 
box or removing the mains-cable. 
 
2. Operation, service and maintenance 
 
The CPA system needs no operation, service or maintenance. The proper function 
can always be easily checked by performing the “Quick Check” (see page 39) 
 
3. Safety information 
 
The CPA central control box, the CPA sensor and the CPA sensor-cable contain 
high voltage and thus must be handled only by authorized personnel. 
 
4. Warranty: 
 
The manufacturer warranty for all CPA system components is – if not otherwise 
agreed - two or ten years depending on version STD or MIL, beginning from date of 
delivery, covering any material and/or manufacturing defects. 
 
Breaking the warranty security seals and/or opening or manipulating the 
CPA sensor-unit will void any warranty and cause system failure. 
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Equipment needed for the hardware installation: 
 
- wall drilling machine with 10 mm drill for CPA sensor-cable 
- wall drills 8 and 6 mm for dowels 
- silicone to tighten the cable hole 
- cleaning equipment 
- soldering iron for tinning wire ends only 
- normal electronic installation tools like screw-drivers etc. 
- digital voltmeter ac/dc max.750 v ac/dc 
 
There is a bag enclosed with CPA system accessories & spare parts on the right 
bottom side in the CPA central control box which contains all dowels, screws, etc. 
for the installation: 
 

 
 
Important: 
 
For the designated use as an early warning system for accidents or possible attacks the 
CPA sensor-unit must be installed at an outside wall of the building in the free air 
and best – but not necessarily – near the house entrance 
 
(see also pictures here: www.schaefer-physik.de ) 
 
But for bench test purposes the CPA sensor-unit can be connected to the CPA central control 
box and be tested inside the building, because under normal conditions the natural radiation 
coming from space is the same inside and outside a building. But to register an accident or 
attack as early as possible - as this will first occur in the outside surrounding air -  therefore 
the CPA sensor-unit must be installed at an outside wall of the building. 
 
The CPA sensor-unit can be hidden in a bird-house, housing of wood, plastic, net, thin 
metal, etc. Its sensitivity and reliability will not be affected by water, dirt, dust, bird nests or 
any other materials covering it. It can also be painted with any paint. 
 
The CPA sensor-unit contains very sensitive elements. The metal housing is sealed 
and protected against unauthorized opening. Trying to open the CPA sensor-unit 
will destroy the sensor and void the warranty!  
 
Handle the CPA sensor-unit always with care! 
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Installation of the CPA system: 
 
The CPA system scope of supply contains the following parts: 
 
1.   the CPA central control box containing the CPA main-unit, CPA monitor-unit and  
      CPA  gsm-cellphone-unit 
2.   the CPA sensor-cable connection-block inside the CPA central control box 
3.   the 230 vac mains cable connection-block inside the CPA central control box 
4.   the CPA sensor-unit with attached and ready connected 25 m / 75 ft cable 
5.   spare fuses 0,2 A for the CPA main-unit and CPA monitor-unit 
6.   a kit of accessories  
7.   programming software and programming manual for the CPA gsm-unit on 
      usb stick /CD-ROM 
8.   usb cable for programming the CPA gsm-unit using a Windows-pc 
9.   this technical installation manual 
10. a user manual for the owner 
 
The main steps for the CPA system installation are as follows: 
 
1. mounting the CPA sensor-unit at an outside wall of the building in the free air 
2. run the CPA sensor-cable through the wall to the CPA central control box 
3. mount the CPA central control box to a wall inside the building in a distance of not  
    more than max 25 m / 75 ft from the CPA sensor-unit 
4. connecting the sensor-cable inside the CPA central control box 
5. check the correct connection of the CPA sensor-cable twice (especially pin 4 yellow) 
    before connecting the mains supply 
6. connecting the CPA system to the 230 vac single phase mains 
7. check the CPA system functions 
8. program the cellphone-numbers via Windows-pc into the CPA gsm-unit 
8. check the CPA gsm-unit sms function to user cellphone(s) 
 
For the gsm-cellphone-sms alarming system you need in addition: 
- an active sim card standard size 25 mm without pin! (e.g. typical for alarm devices 
   and only gsm / telephone / sms – function > without internet function 
- the max. five cellphone-numbers that the user wants for his alarming sms . 
 
Later you will see that there is a function provided to send sms-test-messages off the 
CPA system without an active alarm. 
 
Important to read BEFORE starting: 
 
Do not connect the CPA system to the 230 Volt mains before reading these installation 
instructions completely – because the connection of the 230 vac mains will be the LAST 
step after the complete hardware installation – otherwise expensive parts could be 
destroyed.  
 
The CPA system has no on/off switch nor any operation elements or so because it runs 
automatically 24 hours /day-365 days/year. The customer doesn't have to care about 
anything at all. 
 
The complete function – including alarming - of the CPA system is controlled by the 
CPA sensor-unit in connection with the CPA central control box and the sms alarming 
to cellphones via the CPA gsm-unit. 
 
The CPA monitor-unit and its controls do not affect the permanent function of the 
CPA system, but is only to produce visible (red scan-LED and digital counter) and 
hearable (sounder) signals produced by the permanently irregular (about 50 to 1000 
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or more per hour) “space photons” (= natural radioactivity) to check the system 
functionality at all times: 
 
This pulse-indication is a permanent control for the full and reliable function of  
the CPA system. 
 
The on/off switch at the CPA monitor-unit is to switch only the CPA monitor-unit itself 
on/off and has no effect to the function of the CPA system nor the CPA gsm-unit – 
normally it stays on to be able to check and prove the proper function of the system. 
 
 

 
 
 
 
There can be a custom-designed alarm-device (not enclosed) be connected to the 
2-pin alarm-device connector right to the 230 vac mains connections. 
For more information see the descriptions 
- “connection to 230 volt mains supply” (page 12) and 
- “Appendix A, CPA installation of additional external alarm-devices” (page 16) 
 
Important: the CPA system has no main switch : when connected to the mains 
it runs continuously and should never be cut-off . After a possible power-down 
failure it automatically restarts and logs in to the cellphone net. 
 
Important: the 5 pin sensor-cable connector contains a high-voltage pin = pin 4 (yellow 
wire). This high-voltage can be between 500 – 700 vdc. 
 
Caution: 
the CPA sensor-unit housing is sealed and protected against unauthorized 
opening. Trying to open the CPA sensor-unit will destroy the sensor! 
Handle the CPA sensor-unit always with great care!
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The CPA system installation procedure step by step: 
 
step 1: 
find a place for the CPA sensor-unit – at the house-wall outside the building in the free 
air. The CPA sensor-unit should be mounted in a height (above 3 meters) where people can 
not reach the CPA sensor-unit or its cable and damage it. The CPA sensor-unit is absolutely 
weather-proof and rugged in full metal. It is hermetically tight sealed - do not try to open it 
- you will destroy it. 
  
For the CPA sensor-unit cable (7 mm diameter, 4 wires + shield) use an existing opening or 
drill a hole in the house-wall, leading to the CPA main-unit. This cable must not be longer 
than 25 meters (75 ft), but can be cut short to any convenient length depending on 
the local conditions. Seal the cable hole in the wall again professionally and aesthetically. 
 

 
 
step 2: 
find a place for the CPA central control box (including CPA main-unit, CPA monitor-unit and 
CPA gsm-unit) so that the max. CPA sensor-cable length (25 meters = 75 feet) must not be 
exceeded but can be cut short and check that there are no big metal parts next to the 
CPA central control box top side that could shield or influence the gsm-cellphone signal 
communication, because the internal CPA gsm-antenna is located directly under the box top. 
 
The CPA central control box can now be fixed inside the building using 4 dowels and screws 
(are supplied). The measurements for the holding-screws are shown below. 
 

  
 
Now mount the three cable inlets (supplied) into the holes in the bottom of the CPA central 
control box and fix their nuts inside. 

Important: if the customer wants to hide the 
CPA sensor-unit in a bird-box or protect it against 
nesting birds, etc., the CPA sensor-unit can be 
covered with a housing of wood (e.g. bird-box), 
plastic, thin metal, net or wire-mesh without 
affecting the performance of the CPA sensor-unit. 
Also sun, UV, rain, dirt, hot, cold, etc., does not 
harm it. It can even be painted with any paint. 

cable inlets: 
 
1 = 230 vac mains cable 
2 = sensor-cable 
3 = auxiliary custom-made 
      alarm device connection 
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step 3: cut the CPA sensor-unit cable (4 wires + shield)  to a convenient length and 
connect it at the right connection-block inside the CPA central control box. 
 
Strip the 4 wire-ends of this sensor-cable for about 1/3 inch and twist all wire ends, 
disentangle the shield net, twist it and tin all the wire ends and put a piece of isolation 
(enclosed) onto the long shield-wire: 
 

  
 
Now loosen the screw-cap of the cable inlets at the bottom of the CPA central control box 
and insert the sensor-cable: 
 

   
       
Connect all cores to the screw-terminal wire per wire, exactly matching the core-colours 
plus the shield as the already connected wires coming from the CPA main-unit: 
 

   
 
Match wire colours exactly!        Tighten the screw-cap at the cable-inlet  
 
Check your wiring TWICE very carefully – there is a 500-700 vdc high-voltage wire 
(YELLOW) which - if wrongly connected – destroys the sensor in a second!  
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Check the sensor-cable wiring 
TWICE before connecting the 
CPA system to the 230 vac mains 
supply! 
 
Remark: this high-voltage has very low energy 
and does not harm you when erroneously 
touching it (what you should not do anyway) – 
it is like an electric cattle-fence 
 
Important: the measurement of the high 
voltage (between pin 1 and pin 4) with a 
voltmeter reduces the high voltage and the 
CPA system responds with a full scale of the 
analog instrument, alarm is triggered at once, 
which would immediately send an alarm-sms 
message. 
To avoid an alarm-sms to the customer in 
this case, this measurement should be 
made before a sim card is inserted. 
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step 4: connection to 230 vac or 120 vac mains supply: 
 
Important!: Now first take out the main-fuse at the CPA main-unit 
 
Now connect the single phase mains supply wires to the left connection-block inside the CPA 
central control box as shown below: 
 

 
 
 
If an optional UPS-power supply is used, the 230 vac mains connection is 
performed by a direct cable with plug to this UPS-power supply unit. 
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If an optional UPS-power supply is used, the 230 vac mains connection is 
performed by a direct cable with plug to this UPS-power supply unit. 
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Please observe carefully the different effects that will happen to the CPA system at the 
moment of connecting it to the mains - please read below first: 
 
In the moment when connecting the CPA system to the mains supply, 
the following effects occur at the CPA main-unit: 
 
- first you will hear a short metallic “click”-sound (relay), you will hear a short (alarm-)beep 
   and the red alarm lamp will lighten shortly. 
- Then the green lamp lights on the main-unit continuously (system is active). 
- Both orange lights at the analog instrument are lighting continuously, meaning that +500- 
  700 vdc for the sensor-supply is present. 
- There is a small meter deflection at the analog instrument always below scale value 1,0 
 
 

  
  
 
Now activate the CPA system by re-inserting the main-fuse into the CPA main-unit again 
and check if all the above mentioned effects occur – installation will be ok. 
 
If all this does not occur: 
 
Error detection at the CPA main-unit: If nothing happens, no lamps are lighting, no 
orange light at the top of the meter at the CPA main-unit: 
 
check the main-fuse (0,2 A bzw. 0,5A – spare fuses are supplied) at the left bottom part of 
the CPA main-unit inside the CPA central control box 
 
 

 
 
Remark: the fuse at the CPA monitor-unit right side has no effect on these functions of 
the CPA main-unit but only to the CPA monitor-unit and CPA gsm-unit. 
 

Both orange lights at the interior top of 
the analog instrument are lighting 
continuously, proving that the high-
voltage for the sensor supply is present. 
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Check the 230/120 vac mains-supply by measuring the voltage at the 230/120 vac mains 
connection-block (left) and measuring the voltages at the CPA sensor-cable connection-
block (right) 
 

 
 
 
If necessary, replace the main-fuse or correct the mains-supply or cable 
connections 
 
Important: If the CPA main-unit analog-meter shows full scale deflection and alarm is 
generated (red lamp lights and alarm-sounder beeps) either the connection wiring is wrong 
or the sensor itself is destroyed. Disconnect the system from mains and check the cable 
connections. 
 
Step 6: complete CPA system function test: 
 
Now switch the CPA monitor-unit on, reset the digital-counter to zero, switch the sound-
switch to “beep” an check the irregular pulses (about 50 to 1000 or more per hour), 
indicated via sound, red LED and digital counter. 
 

 
 
Wait and listen and observe the scan-LED and digital counter: there should be about 
50 to 1000 or more pulses per hour in irregular intervals, caused by photons coming from 
outer space (= natural radioactivity) – you will hear and see these photon-pulses at the 
CPA monitor-unit.  
 
These pulses show that the installation is correct and CPA system is working fine. Now 
leave the CPA monitor-unit switched on and sound-selector to “beep”. If the “beeping” 
disturbs the customer, switch sound selector to “tick” or “off”.  
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Congratulations! Good job - these permanently indicated and counted irregular 
pulses (50  - 1000 per hour) at the CPA monitor-unit prove that the whole system 
is working properly. 
 
Next step is the programming of the CPA gsm-unit for the cellphone-sms alarming function 
– see separate manual 
“CPA GSM-Unit programming and software installation manual” 
(page 21). 
 
After a successful test of the CPA gsm-unit by sending a test sms message to the owner’s 
cellphone(s) the CPA system installation will then be completed (page 34). 
 
From now on during normal operation the following indications occur:  
 
- the green lamp (ACTIVE) lights continuously at the CPA main-unit 
- the orange lamps at the top of the meter light continuously at the CPA main-unit 
- there is a small deflection at the analog instrument (CPA main-unit) of always 
  below scale-value 1,0 
- the green lamp flashes very slowly at the CPA gsm-unit and 
- red scan-LED, digital-counter and sound-output indicate pulses at the CPA monitor-unit  
 
see also the instruction-video “The CPA system function & test.mp4” 
here: www.schaefer-physik.de/downloads 
 
Please put the bag with the remaining spare-parts now into the lower right part 
of the CPA central control box 
 
 
 
www.schaefer-physik.de   -   email: mail@schaefer-physik.de 
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Appendix A 
CPA installation of additional external alarm-devices 
 
This can be necessary if the customer wishes additional alarm-devices like flashlight(s), 
siren(s), etc., or if there is no (temporary) gsm-cellphone-net available, like on ships on  
high-seas, remote areas, etc. 
 
There is a switching output provided at the CPA central control box – the switch is closed 
during an alarm-situation and normally open. 
 

             
 

          
 
           max. alarm-contact load = 250 volt ac/dc at max. 1 amp 
               alarm-test procedure see next page (page 19) 
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Manual alarm triggering with/without sending a sms: 
 
A test-alarm can be manually generated by using a normal digital universal voltmeter and 
measuring the high-voltage (500–700 vdc) across pin 1 (brown / ground) and pin 4 (yellow 
/ high-voltage) at the CPA sensor-unit cable connector in the CPA central control box. 
 
 
 

 
Triggering an alarm: 
The following effects will occur: 
1. the analogue meter at the CPA main-unit will show a deflection 
2. the green led (ACTIVE) at the CPA main-unit will turn off and  
    the red led (ALARM) lights up 
3. an acoustical alarm sound comes up 
 
Performing the test: 
1. bring the measurement cables of the digital voltmeter in contact with the above described 
    two pins and hold them in contact for at least 10 seconds 
2. an alarm is now generated depending on the chosen upper method 
3. after releasing the measurement cables from the pins, the analogue instrument will 
    slowly return to zero and the alarm lasts for some seconds before turning off. 

Procedure for a manual alarm-test 
WITH sending an alarm sms-messages 
to the owner’s cellphones: 
 
measuring the high-voltage between pin 1 
and pin 4 will put such a load to the high-
voltage-source that an alarm will be 
triggered. 
 
Important: 
this measurement includes the test of the 
function of the switch for additional external 
alarm-devices (see page 18). 
 
Procedure for a manual alarm-test 
WITHOUT sending an alarm sms-
messages to the owner’s cellphones: 
 
should the sending of an alarm-sms to the 
owners cellphones be prevented during this 
test, take out the fuse at the CPA monitor-
unit at the lower right (left of the switch) 
position. 
 
Attention: 
put the fuse in again after this test, 
otherwise the gsm-unit stays switched 
off and dead. 
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Summary 
 
see also the instruction-video “The CPA system function & test.mp4” 
here: www.schaefer-physik.de/downloads 
 
- The CPA system has no main-switch and runs permanently 24h/7d/365d/year. 
- The CPA main-unit has no control elements and operates fully automatically. 
- The CPA system is designed and manufactured in military solid-state technology and 
   needs no care, service or maintenance. 
- The CPA system user needs no knowledge, actions, control or care. 
 
 
Indicators at the CPA main-unit: 
 
- The green light = system is active armed and scans and watches the outside environment. 
 
- The red light = alarm with additional acoustic sound i.e. the system has discovered an 
   anomaly in the air and alarms. 
 
In this case a sms-cellphone warning is sent to the pre-programmed max. 5 different 
cellphone-numbers of the owner. 
When the alarm is over and the lamps at the CPA main-unit change from red back to green 
a further cellphone-sms is send to the pre-programmed cellphone-numbers that informs the 
owner that the alarm/danger is over. 
 
The controls and indicators at the CPA monitor-unit have no influence to the full automatic 
function of the CPA system. They only allow to make signals visible and hearable. 
No matter how the controls at the CPA monitor-unit here are positioned, the CPA system 
runs fully functional. 
 
The CPA is a fully automatic system, consisting of a sensor-unit mounted outside in the free 
air, a main-unit based on artificial intelligence, which handles the sensor signal and 
generates an alarm, if there is a threat in the air, a monitor-unit which makes sensor-signals 
visible and hearable and a gsm-unit which sends cellphone-sms messages in case of an 
alarm situation. 
 
The CPA has no on/off switch or so, because it runs automatically 24 hours/day-365 
days/year. The on/off switch at the monitor-unit does not affect the main-unit, but it is only 
to switch the monitor-unit itself off to prevent unwanted visible or hearable signals. 
 
 
 
 
Contact and support: www.schaefer-physik.de   –   email: mail@schaefer-physik.de 
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CPA GSM-Unit 
software installation and 

programming manual 
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Equipment needed for the software installation 
and programming of the CPA GSM-Unit: 
 
 
- WINDOWS-pc (WIN7, 8, 10 - 64 or 32 bit) with usb-connector  
 
- usb-mini cable (enclosed) 
 
- CPA gsm-unit programming software (enclosed) 
 
- a sim card standard size 25 mm without pin! (e.g. typical for alarm devices 
   and only gsm / telephone / sms – function > without internet function 
 
 
 
 
 
Attention – very important: 
 
Before inserting or changing the sim card, the CPA gsm-unit must be switched off 
by taking out the fuse at the CPA monitor-unit – see red arrow at the picture below. 
 
The ON/OFF switch to the right has no effect to the power-supply of  
CPA gsm-unit. 
 
 

 
 
 
After programming / uploading the software to the CPA gsm-unit, the 
CPA gsm-unit must be re-started to log into the cellphone-net by 
re-inserting this fuse at the CPA monitor-unit. The green led at the 
CPA gsm-unit will then restart flashing slowly. 
 
Naturally cutting off the power can also be done by cutting off 
the 230 vac mains. 
   

By taking out the fuse (red arrow), 
the power-supply of the CPA gsm-unit 
is cut off.  
The green led at the CPA gsm-unit 
stops flashing. 
 
The switch “ON/OFF” to the right of this 
fuse does NOT cut off the power supply 
to the CPA gsm-unit, but only the 
optical and acoustical displays. 
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CPA GSM-Unit programming manual 
 
Purpose: in case the CPA system detects a threat / danger and generates an alarm, the 
CPA gsm-unit sends a sms message to max. 5 different cellphone-numbers with a text, 
informing its owner about the danger or that the danger is over. 
 
Information for the installation technician: 
There is a test-procedure incorporated that enables the installing technician to send a sms 
test message without a real alarm situation to check the CPA gsm-cellphone-sms function. 
For test purposes the installation technician can also temporarily program his own 
cellphone-number and then remove it again. 
 
Programming the CPA gsm-unit (cellphone alarming system) 
 
All needed software and information will be on an attached usb-stick or cd-rom in a folder 
called “CPA GSM-UNIT software installation” or can be downloaded at 
www.schaefer-physik.de 
 
This software folder should be copied to the installation Windows-pc for easier use later. 
Remove any write protection from the CD-ROM files. 
 
 
The software installation consists of the following steps: 
 
1.   transfer the installation folder from the usb-stick / cd-rom to the Windows-pc 
2.   installation of the usb to serial device driver on the pc 
3.   installation of "Microsoft NET Framework 3.5” 
4.   installation of the program "Elmes GSM2 Configurator" on the pc 
5.   setting the COM port in the "Elmes GSM2 Configurator" program 
6.   loading the prepared data set into the "Elmes GSM2 Configurator" program 
7.   programming the customer’s data 
8.   upload this data from the pc to the CPA gsm-unit 
9.   sending a test sms 
10. saving the customer data file 
 
Attention – read this first: 
the CPA gsm-module is – like the complete CPA central control box – permanently switched 
“on” as long as the CPA system is connected to the mains supply. The ON/OFF switch at the 
CPA monitor-unit does not affect the power supply of the CPA gsm-unit or CPA main-unit 
but only the CPA monitor-unit optical and acoustical display. When the CPA gsm-unit has its 
power supply active, the green LED at the CPA gsm-unit is permanently flashing slowly. 
 
Important: before inserting the sim card switch off the CPA gsm-unit! 
 
before inserting/replacing the sim card the CPA gsm-unit’s power supply must be cut-off 
 for logging in. This must be done by taking out the fuse at the CPA monitor-unit  
 (see page 22) 
 
after having inserted the sim card, restart the CPA gsm-unit by re-inserting this fuse and 
the green led at the CPA gsm-unit will start again flashing slowly. 
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Preparing the CPA GSM-Unit for operation: 
 
Provide an active sim card (standard sim format 25mm) without pin-code 
 
Cut off the supply voltage for the CPA gsm-unit (see page 21-22) by taking out the fuse at 
the CPA monitor-unit and the green led goes off. Switching off the main switch at the 
CPA monitor-unit does not cut off the supply voltage to the CPA gsm-unit! 
 
Opening the CPA gsm-unit cover: 
 

  
press gently against left housing side             and swivel to right to open the snap-in 
 
Please treat the sim card holder very gently – it is somewhat fragile. 
 
Insert a sim card (standard sim format 25mm) without a pin-code into the  
CPA gsm-unit: 
 

         
       
    shift sim card holder gently to the right          and open it to the right upwards 
 
 
Please DO NOT touch the chip on the sim card nor the gold-contacts in the holder. 
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insert the sim card into the small guide-bars          then slide it down completely  
 

    
 
Now push the sim card holder down – check that the sim card fits exactly in its “bed” 
and shift the holder to the left to lock it. 
 
Now re-insert the fuse at the CPA monitor-unit – that powers the CPA gsm-unit on and the 
green LED at the CPA gsm-unit will start flashing slowly. The CPA gsm-unit with its 
sim card is now initiated and a connection to the gsm-net is established automatically. 
 
Programming: 
 
Programming is done by means of a Windows-pc (WIN 7, 8, 10 - 64 or 32 bit), connected 
to the CPA gsm-unit via a usb-cable (supplied). This connection is a usb-plug at the pc side 
and a serial COM interface (mini USB) on the CPA gsm-unit side. 
A so-called "USB serial port (COM)" Windows device driver is required to enable this 
connection. Most Windows versions have such a driver on board and this is automatically 
activated when the cable connection to the CPA gsm-unit is plugged in and displayed in the 
device manager as a new usb serial port COMx. If the driver has to be installed manually, 
this will be explained later in the manual. 
 
The programming itself is very easy and done by transferring a program (text)-file from 
the pc to the CPA gsm-unit. This text file contains already all operation-parameters 
(pre-programmed by the manufacturer) and requires only the addition of the customers 
cellphone-numbers  
 
This will be explained in detail later. 
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All Steps for the software-programming 
 
Important: Windows administrator rights are required for the complete installation. 
 
step 1: 
copy the complete folder "CPA GSM-Unit software installation" from the enclosed usb-stick 
or cd-rom to the pc. Files coming from the cd-rom may be write-protected, remove this 
write-protection by right-clicking on the file and select > “Properties”. 
 
step 2: 
Info: For the data connection between pc and CPA gsm-unit a mini-USB cable (included) is 
used and for data transmission itself an "usb to serial" device driver is necessary, which is 
usually already available in Windows 10. 
 
Open the Windows 10 Device Manager an check the arrow position (com ports): 
 

 
 
Further action: the CPA system must be switched on and active, the green LED on the 
CPA gsm-unit flashes slowly. Now connect the CPA gsm-unit mini-usb-connector with 
the attached usb-cable to your Windows-pc unit (see picture below): 
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Windows 10 can automatically detect the new device and display an additional interface, 
namely “usb to serial com port com5” (or other number) pops up in the Device Manager: 
 

 
 
By this, the data connection is established correctly. 
 
Possible problem: Windows versions 7_8_10 do not establish the “usb to serial com port” 
automatically after connecting the usb cable between pc and gsm-unit 
 
solution: in the programming-folder: „CPA GSM-Unit software installation“ and there 
in the subdirectory „Driver usb serial port comx Windows 7_8_10“ - now start – depending 
on your 32/64 bit Windows version -  the installer file „CP210xVCPInstaller_x86 or x64.exe“  
by double-clicking onto it. Then check the device-manager if the new „USB to Serial Comm 
Port“ is installed. 
 
The CPA system remains switched on and active and the cable connection between 
CPA gsm-unit and pc remains connected. 
 
step 3: 
"Microsoft.NET Framework 2.0" must be installed on the pc - if this is not the case, then 
start the attached “Microsoft.NET Framework 3.5” by double-clicking on the folder 
"CPA GSM-Unit software installation" and the file “dotnetfx35.exe” (includes version 2.x) 
and install (takes a few minutes). The version 2.x is no longer included in some new 
NET.Framework versions which will not work then. 
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Further procedure for software installation: 
 
step 4: 
Now the program "Elmes GSM2 Configurator" can be installed: double-click on the file 
“CPA gsm-unit software install.exe” in the folder "CPA GSM-UNIT software installation" 
and follow the on-screen instructions. After completing the installation, the program 
"Elmes GSM2 Configurator" appears in the list at "Windows > Start > All Programs". 
 
Now start the program "Elmes GSM2 Configurator" and 
the following screen appears (tab “Inputs”): 
 

 
 
step 5: 
Setting the COM port in the program "Elmes GSM2 Configurator". 
 
The first step after starting ELMES GSM2 CONFIGURATOR is to select the serial COM port 
for communication with the CPA gsm-unit: Menu item > Options > Settings. 
The same COM port must be selected here by clicking on the small black triangle on the 
right in the window, which was also configured for the previous usb cable installation and is 
displayed in the Windows Device Manager as USB Serial Port (COMx): 
 

 
 
Next go to the menu item Tools > Diagnostics. Check the correct communication between 
pc and CPA gsm-unit by means of the gsm-signal level (green bar) indication - there you 
can see that the CPA gsm-unit is registered in the gsm-network and the communication with 
your pc is active: 
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If this is not the case, check that the CPA gsm-unit is active = green LED flashes slowly. 
Repeat the above steps to install the sim card, usb cable, usb cable-driver and 
CPA gsm-software. 
 
step 6: 
load the prepared dataset-file into the program "Elmes GSM2 Configurator", 
which will then be only on the pc(!) first: 
 
Select in the menu item File > Open  
 

 
 
and from the folder "CPA GSM-Unit software installation" load the file 
“CPA system GSM EN 1.txt”. Then the following screen appears (tab “Inputs”): 
 

 
This program file "CPA system GSM EN 1.txt" is now only located in the PC and already 
contains all data and parameters required for the operation of the CPA gsm-unit.  
 
BUT WITHOUT: customer-specific data such as cellphone-numbers for alarming  
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Important:  
Do not modify any check boxes or values in the different menus. If in doubt, reload the 
file "CPA system GSM EN 1.txt" and start from scratch again. 
 
If the customer owns several CPA systems at different locations, the individual location or 
number of each CPA system can be entered in the text fields shown below replacing the 
red example text. 
 
Attention: 
ONLY add the text there - DO NOT change any other values or parameters on this page - 
if something goes wrong, you can start again by reloading the file  
"CPA system GSM EN 1.txt" from scratch. 
 

 
 
 
 
Next - step 7: will be the input of the custom data (page 31). 
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step 7: 
Next go to the tab > Phones->Outputs. Enter here max. five cellphone-numbers of the 
customer with country code (without zero, as international standard – like: 
+44123456789): 
 

 
The check marks in the "Set OUT1" column must be set for each telephone number. 
   
Next go to menu tab > Inputs->Phones and check if the max. five programmed 
cellphone-numbers which do pop up here then also automatically: 
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step 8: 
Now the pc programming is complete and the data must be transferred (uploaded) from 
the Windows-pc to the CPA gsm-unit. This is done by clicking on the upload icon here:  
 

 
 
choose than the selection „All“ > “OK”: 
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step 9: 
 
Sending a test sms to check the complete function of the CPA GSM-Unit: 
1. open the CPA gsm-unit – see page 24 
2. there is a small microswitch with metal cover on the gsm-unit’s board (below the 
antenna) for triggering a test-sms 
 
(A “real” alarm can be generated by using the method described above in section 
“CPA hardware installation” - “Appendix A” (page 18 – but is not required here.) 
 

  
 
Pressing down and keeping this microswitch for min. 5 seconds and then releasing will 
send two sms-messages to the programmed cellphone-numbers: 
 
1. “CPA TEST OK ON” 
2. “CPA TEST OK OFF” 
 
With the usb-cable connection between CPA gsm-unit and Windows-pc is still existend, this 
function can be checked by going to Menu > Diagnostics > there the check-box “Input 4” 
will turn red as long as the microswitch is pressed: 
 

 
 
If this test is successful, the installation is complete. 
 
 

Pushing down the little silver metal 
part towards the pcp is the switch 
actuator - a “click” will be hearable 
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step 10: 
 
Now very important (save your programming): 
Next go to menu > File > Save as > and save the completed configuration file that you 
have transferred / uploaded to the CPA gsm-unit before as a file with attached customer 
name: “CPA system GSM EN 1 xxxxx.txt”  to have it for future purposes for this 
CPA system. You should also save this file to the usb-stick. 
 
Now close the cover of the CPA gsm-unit, after removing the usb cable: 
 

  
 
Apply the right side first, fitting the nose into the gap and then swivel to the left and gently 
press to snap in – check the LED fitting in the cover-hole. 
 
Congratulations – good job – you are done successfully! 
Now put the spare parts into the CPA central control box (on the right bottom), close the 
door and lock it. And please put the usb-cable and usb-stick / cd-rom back into the 
manual-folder. 
 
 
Please do now hand out the enclosed (in the installation file) printed 
“CPA system user information” (left pic) to the customer: 
 
 

              
 
 

Now download the file 
(see right pic) 
„CPA system alarming what to 
do.jpg” 
to the user’s mobile phone, so he 
can read it with one tap on the 
screen – or have the user’s 
sysadmin do this. 
 
This file is located on the 
installation usb-stick/cd-rom or 
can be downloaded from: 
www.schaefer-physik.de 
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Service Contract 
 
Now do offer the customer a service contract for the CPA system, which you design 
yourself according to organization and costs and close directly with the customer. 
 
While the CPA system does not require any maintenance or service, a service contract can 
be very useful to increase customer’s confidence in the CPA system and enhance his sense 
of security. 
 
A service contract should be offered for periodic maintenance of the CPA system between 
once and twelve times a year. Inform the customer that maintenance is not absolutely 
necessary technically, but is highly recommended in terms of device safety. 
 
Work to be carried out as part of the maintenance of the CPA system: 
 
1. Visual inspection of the CPA sensor system for heavy dirt (bird's nest, etc.) 
2. perform a quick check self-test for the CPA system 
3. Sending a test SMS according to page 33 of this manual 
4. in accordance with the owner triggering a manual alarm according to the procedure  
    on page 19 of this manual in mode 1 (procedure for a manual alarm-test with sending an 
    alarm sms-message to the owner’s cellphones) 
5. check the correctness of the programmed cellphone-numbers 
6. Check the empty top side of the CPA main-unit housing, see page 10 of this manual 
    (keeping the GSM antenna free) 
7. The maintenance should be documented with a receipt-copy, which is stored in the 
    CPA main-unit housing. 
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CPA GSM-Unit trouble shooting 
 
Troubleshooting if no SMS is sent: 
 
 
1. The CPA gsm-unit has no power – i.e. the green led at the the CPA gsm-unit is not 
slowly flashing, but all CPA system functions according to CPA system quick-test (see page 
39) are ok 
 
Solution: check/replace the fuse at the CPA monitor-unit 
 
 
 
2. The CPA gsm-unit does not send SMS? 
 
Solution: the sim card has a pin – any pin must be erased because only sim cards 
WITHOUT a pin must be used 
 
 
Solution: the sim card is not registered or activated from the provider or it is not 
precharged or payed 
 
 
 

3. The CPA GSM-Unit does not initialize (the green LED does not flash slowly but flashes 
fast 
    in 1s rate then sets off for few seconds and starts flashing cycle again)? 
 
Solution 1: sim card has a pin-code and therefore can not log in – remove pin-code from 
sim card. 
 
Solution 2: check for proper sim card contacting in the sim socket. If necessary, clean all 
contacts. 
 
 
 
4. On attempt of sending data from the CPA gsm-unit while in communication mode with 
PC 
    „Out of Time” message appears? 
 
Solution 1: improper COM port is selected in menu “Options >Settings”. The COM number 
has to match that what appears when usb cable is plugged to pc and what disappears when 
unplugged.  
 
Solution 2: the USB interface drivers are either not installed yet at all or installation is 
faulty. Drivers are available on enclosed usb-stick / cd-rom or for download at 
www.schaefer-physik.de . After installation a new COM port should appear. 
Incorrect driver folder name given at installation is a frequent mistake.  
 
If driver installation has failed, it should be uninstalled with the cable still plugged, then 
unplug the cable, wait one moment, plug to the pc again and follow driver installation steps 
described as above in this manual. 
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Solution 3: if none of the above solves the problem, follow steps as below:  
a. unplug and plug the usb cable to the pc or  
b. switch off the CPA gsm-unit’s power supply (= taking out the fuse at the 
    CPA monitor-unit) and unplug the usb cable from the pc, then switch on the module’s  
    power supply (= re-inserting the fuse at the CPA monitor-unit) and plug the 
    usb cable to the pc, 
c. plug in the usb cable to other usb socket in the pc. 
 
 
 
5. The „GSM2 Configurator” software does not start up?  
 
Solution: missing Windows component: „Microsoft.NET Framework 2.0”.  
 
"Microsoft.NET Framework 2.0" must be installed on the pc - if this is not the case, then 
start the attached “Microsoft.NET Framework 3.5” by double-clicking on the folder 
"CPA GSM-Unit software installation" and the file “dotnetfx35.exe” (includes version 2.x) 
and install (takes a few minutes). The version 2.x is no longer included in some new 
NET.Framework versions which will not work then. 
 
 
 
6. On attempt of sending or receiving data from CPA gsm-unit to pc the message 
    “access to port COM-x is denied” appears? 
 
Solution: this error may be due to other software application using this port. For example a 
WLAN & Internet usb-stick or e.g. “Sony Ericsson PC Suite” periodically tests COM ports for 
a phone presence and, in consequence, block the port access. To solve the problem the 
following steps should be tried: 
 
a. disconnect out other usb cable/ -sticks from the pc, 
b. wait few seconds and try data exchange again,  
c. disable software application, blocking the port.  
 
 
 
7. On attempt of sending or receiving data from CPA GSM-Unit to pc the notice  
    “COM PortX does not exist” appears?  
 
Solution: after selecting in the menu > “Options > Settings” the proper COM ports, 
the usb cable was unplugged.  
 
www.schaefer-physik.de – email: mail@schaefer-physik.de 
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CPA system trouble shooting 
 
 

CPA system overview 
 

see also the instruction-video “The CPA system function & test.mp4” 
here: www.schaefer-physik.de/downloads 

 
 
 

 
 
 
 
CPA GSM-Unit trouble shooting 
 
see above  „CPA GSM-Unit trouble shooting“ / here in the CPA GSM-Unit installation- and 
programming manual, page 36. 
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CPA system trouble shooting 
 

Quick check for the CPA system using the CPA system 
built-in self-test-function (also for laymen):

The registered pulses (ca. 50 - 1000 per hour) are generated 
by the natural background radiation:

1 2
3

45

8

6

7

CPA ai electronic unit

CPA monitor-unit

the green lamp must be lighting

two orange lamps must be lighting

the green led must be flashing 
slowly

the switch must be set to „ON“

„SOUND“-switch set to „beep“

Monitoring the pulses

Basic function

the digi-counter advances per pulse

the red led flashes per pulse

every pulse creates one beep

If the above test shows about 50 - 1000 pulses per hour,
all functions of the CPA system are correct.

1
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6

7

8

 
 
 
 
 

If this test fails proceed to the next page >>> 
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Possible CPA system errors: 
 
Error 1: CPA system seems to be dead with following symptoms: 
 
- green LED on front panel of the CPA main-unit does not light 
- orange lights at the upper edge of the analog instrument do not light 
 
Solution: 
 
- check if all three 230 vac mains wires are correctly connected to the mains connection 
  block (on the left) 
- check if the 230 vac mains voltage is existent and correct  
- check/replace the main fuse 0,2 A at the CPA main-unit 
 
if this solution does not work, the CPA main-unit is defective and must be replaced. 
 
 
 
Error 2: system shows no random optical or acoustical pulses (about 50 to 1000 or 
more per hour) at the CPA monitor-unit’s indicators 
 
- but green LED on front panel of the CPA main-unit is lighting 
- but orange lights at the upper edge of the analog instrument are lighting 
 
Solution: 
 
- switch the CPA monitor-unit on 
- switch sound-selector to „beep“ 
- digital counter should show any value – reset counter to zero 
- if the digital counter’s display is blank (no number indicated) then check/replace the 
  fuse at the CPA monitor-unit 
- you should see and hear now slow random pulses (about 50 to 1000 or more per hour) 
  at the CPA monitor-unit indicators 
  
if this is NOT the case, check for correctly connected sensor: 
 
 
 
Error 3: not correctly connected CPA sensor-unit or missing voltages 
 
Solution: 
 
- switch the CPA system off by taking out the main fuse at the CPA main-unit 
- check all 10 connection-screws at the sensor-cable connection-block for correct screw- 
  fixed wires and matching wire colours (see drawing next page 41) 
- switch the CPA system on again by re-inserting the main fuse in the CPA main-unit 
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Now check again for slow random pulses (about 50 to 1000 or more per hour) at the  
CPA monitor-unit’s indicators. 
 
If there is still no pulse indication, the CPA sensor-unit may be defective – continue 
to “Error 4”, as follows: 
 
 
Error 4: check for defective CPA sensor-unit 
 
solution: 
 
- switch the CPA system off by taking out the main fuse at the CPA main-unit 
- loosen the lower screw at pin 2 (green wire) at the sensor-cable connection-block 
- remove the green wire coming from the sensor by bending it a bit away from the block 
 

                          

CPA main-unit 
sensor-cable 
connection-block 
(the right-hand 
block) 

Using a digital voltmeter to check the following 
dc voltages: 
between pin 1 and pin 3 = about -6 vdc 
between pin 1 and pin 4 = about +600 vdc 
 
if the above voltages are missing, although 
mains supply is present and the main-fuse is ok, 
then the CPA main-unit is defective and must be 
replaced 
 
pin 1 = signal ground 
pin 2 = analog sensor signal 
pin 5 = cable shield 
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- switch the CPA monitor-unit on 
- switch sound-selector to „beep“ 
- re-insert the main-fuse at the CPA main-unit to power up the system again 
- the green LED at the CPA main-unit has to light up 
- mind, that there is high voltage at pin 4 (yellow wire) at the connection-block 
- now tap several times with the blade of a metal screwdriver (while you hold the blade of 
  that screwdriver by hand) onto the screw at pin 2 (green wire) at the sensor-cable 
  connection-block 
- you should see a deflection at the signal-level meter and perhaps see and hear random 
   pulses at the CPA monitor-unit’s indicators 
 
- if this is NOT the case, the CPA main-unit and the CPA monitor-unit are defective and 
  have to be replaced 
 
- if this is the case, the CPA main-unit and monitor-unit are functioning properly go to 
 “Error 5”, as follows 
 
 
 
 
Error 5: if the above test shows that the CPA main-unit and monitor-unit are functioning 
properly, do the following: 
 
Solution: 
 
- switch the CPA system off by taking out the main fuse 
- re-connect the green wire of the sensor-cable coming from the sensor at pin 2 at the  
  sensor-cable connection-block 
- check all connections at the sensor-cable connection-block 
- re-insert the main-fuse at the CPA main-unit to power up the system again 
- switch the CPA monitor-unit on 
- switch sound-selector to „beep“ 
- you should see and hear now slow random pulses (about 50 to 1000 or more per hour) 
  at the monitor-unit’s indicators 
 
- if this is NOT the case, check/replace the fuse at the CPA monitor-unit. 
 
 
 
Error 6: alarm is not activated   
 
if the alarm is manually triggered by the 600 vdc measuring method (see page 17 of the 
installation manual), but the green LED (AKTIVE) does not switch to the red LED (ALARM) 
and there is no alarm beeping hearable at the CPA main-unit, although mains supply is 
present and the main-fuse is ok, the CPA main-unit is defective and must be replaced. 
 
 
 
Repair work 
 
Any repair work at the CPA system must be performed only by authorized service personnel 
by the manufacturer. 
  

 
 
 


